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1. Tutorial Básico 

1.1. Iniciando o programa SketchUp 
Para iniciar o programa SketchUp, clique no botão “Iniciar” do Windows e selecione 

“Programs”. Vá para o diretório onde você instalou o programa e clique no item chamado 
SketchUp. 

SketchUp irá abrir com uma janela de desenho (Drawing Window) em branco: 
 

 
 

Barras de Ferramentas = Comandos 

Area de Desenho 

Eixo Y 

Eixo X 

Barra de Título 

Barra de 
Status 

Value Control Box = VCB 

Menus de Barra 

Vista de Topo = Top View  = Vista em Planta 
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1.2. Barras de Ferramentas (Toolbars) 

As Barras de Ferramentas do SketchUp contém todas as ferramentas de construção, desenho, 
edição e visualização que são necessárias para trabalhar no SketchUp. Quando você coloca o mouse 

sobre um botão e pausa, o nome do comando aparece.  
Geralmente, as ferramentas são ativadas clicando no botão do comando e depois retornando 

o cursor para a área de desenho para trabalhar. Para testar coloque o mouse sobre a ferramenta Line 

 e clique com o botão esquerdo uma vez.  

1.3. A Janela de Desenho (Drawing Window) 
(veja figura acima) 
A janela de desenho é um espaço de trabalho 3D, onde você pode movimentar o cursor do 

mouse livremente. As ferramentas e outros comandos ficam colocados em volta. 
A barra de título no topo, traz o nome do seu desenho depois que o arquivo for salvo (antes 

de salvar aparece com “Untitled” (“Sem Título”). 
No canto inferior esquerdo fica a Barra de Status, que mostra mensagens e dicas sobre uma 

determinada ferramenta. Fique sempre de olho na Barra de Status (Status Bar) durante o trabalho, 
para acompanhar as requisições do software. No canto inferior direito fica a Caixa de Controle de 
Dados (Value Control Box = VCB), onde você entra valores precisos via teclado. 
 

 

Eixo Z 

Eixo X 

Eixo Y 

Origem 
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Inicialmente, a janela de desenho mostra uma vista de topo (Top View), que é uma vista de 

cima, em planta, do seu modelo. Para ter uma idéia do espaço 3D, vamos mudar o ângulo de visão, 
selecionando Iso View (Vista Isométrica) no “Menu Camera > Standard > Iso”, ou na barra de 

ferramenta Views Toolbar, selecione o botão Iso . Isto muda a vista para isométrica. 
 

As linhas vermelhas, verdes e azuis, são os eixos de desenho que ajudam na visualização do 
espaço 3D. 

O significado das cores é importante, pois vermelho e verde correspondem às dimensões de 
“X” e “Y”. O plano vermelho-verde corresponde ao plano do chão e será onde você iniciará o seu 
modelo. O eixo vertical é azul; e corresponde a direção “Z” no espaço. 

Nota: Como você normalmente não pensa em termos de XYZ enquanto faz um croquis, 
vamos nos referir aos eixos pela sua cor a partir de agora. 

O ponto onde os eixos se cruzam é chamado origem. Note que os eixos são com linha sólida 
na direção positiva e com linha tracejada na direção negativa. 
 

1.4. Desenhando Linhas (Lines) 

Clique no comando Line   para ativá-lo. 
Note que o cursor do mouse é um lápis. Leve o cursor para a área de desenho, clique e 

arraste o mouse e clique novamente para criar a linha. 

 
Note a dica indicando o ‘Endpoint” (ponto final). 
Desenhe outra linha paralela ao eixo vermelho. Note a dica ‘On Red Axis’ (no eixo vermelho) 

no final da linha. 

 
A cor da linha provisória é vermelha, quando ele é paralela ao eixo vermelho (X). Verde 

quando é paralela ao eixo verde (Y), e azul quando é paralela ao eixo azul (Z). 
 
 
 



CENTRO UNIVERSITÁRIO METODISTA IZABELA HENDRIX 
Curso de Arquitetura e Urbanismo - Disciplina de Informática 

Elaborado pela professora do Centro Universitário Metodista Izabela Hendrix Arq. Cecília Santos Franco 
 

 

6
 
Movendo o mouse antes de clicar no ponto final, a linha provisória se torna magenta quando 

esta for paralela à linha anterior. Note a dica “Parallel to Edge”. Estas são ferramentas de precisão 
de desenho. 

 
 

1.5. Configurando as Unidades (Units) de trabalho 
Como nós, arquitetos, trabalhamos em centímetros, vamos configurar a unidade de trabalho 

para decimal e centímetros. Vamos acessar o “Menu Windows > Model Info > Units”, e configurar 
a caixa de diálogo conforme figura abaixo: 

 

 
 

 

1.6. Criando Faces (Faces) 
Além de linhas, o SketchUp permite que você desenhe faces planas de qualquer forma. Estas 

faces podem ser unidas, divididas, subtraídas umas das outras, esticadas, e tranformadas em objetos 
3D por extrusão. 

Antes, vamos visualizar em modo sombreado (Shaded Mode) . Ou pelo “Menu Windows 
> Display Settings”, conforme caixa de diálogo abaixo: 
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Nota: O SketchUp permite outros tipos de visualização (ver figura acima), como a  

visualização em linhas ocultas (Hidden Line), onde superfícies escondem a geometria que está atrás 
delas. 

Vamos iniciar o desenho de uma face retangular. Com o comando Line , clique um 
ponto em frente do eixo azul para iniciar sua linha. Mova o mouse na direção vermelha, sem clicar 
no ponto final. 

 
Note que enquanto você desenha a linha seu comprimento é mostrado na caixa de valores no 

canto inferior direito da tela (Value Control Box = VCB): 

 
Vamos traçar uma linha de 300cm. Digite 300 usando o teclado, e pressione a tecla Enter. 

 
A linha terá exatamente 300cm, e irá terminar com um quadrado verde indicando um 

Endpoint. Note que a linha criada é agora preta, e o comando Line  ainda está ativo para 
continuar a desenhar. 

 

Wireframe 

X-Ray 

Hidden Line 
Shaded with Textures 

Shaded
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Nota: No SketchUp você pode desenhar com precisão exata, ou de uma forma mais livre de 

croquis sem dimensões precisas. 
Desenhe a próxima linha a 90 graus da primeira (a linha deverá fazer um ângulo de 90 graus 

visualmente em 3D, e não graficamente na tela 2D). A linha deverá ser verde enquanto desenhada, 
isto é, paralela ao eixo verde. Agora digite 240 e pressione Enter. 

 
A linha é desenhada com 240cm. 
Em seguida, desenhe a terceira linha paralela ao eixo vermelho, a linha fica vermelha 

indicando que é paralela ao eixo vermelho. 
Quando o comprimento da linha for próximo do da linha inicial, uma linha tracejada verde 

aparece conectando as duas. A dica do cursor irá mostrar “From Point”. Isto indica que o ponto 
final deste segmento está alinhado precisamente com o ponto inicial da primeira linha. Clique para 
completar a linha neste ponto. 

Agora termine o retângulo clicando no ponto inicial. 

 
 
Dica: Quando você está traçando uma linha e aparece a linha temporária paralela e na cor do 

eixo, antes de clicar o mouse, se você segurar a tecla Shift, a linha paralela ao eixo ficará travada 
nesta direção (a linha temporária vermelha tracejada se torna continua e mais grossa) e você pode 
buscar o ponto de referência em outro ponto já desenhado. A dica “Constrained on Line from 
Point” (linha travada a partir do ponto) aparece na ponta do cursor, indicando que o comprimento 
da linha temporária vermelha está igual ao comprimento da outra linha já desenhada paralela ao 
eixo X, com comprimento de 300cm. Veja figura abaixo: 

 
Após clicar no ponto final, note que o retângulo fica preenchido como uma superfície sólida. 

O comando Line continua ativo, mas não desenha linhas conectadas. 

Linha temporária 
com a tecla Shift
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Para que o SketchUp crie uma face, todas as linhas dos cantos da face precisam estar 

conectadas nos pontos finais, e contidas no mesmo plano. Se houver espaços ou geometrias não-
coplanares, o SketchUp não poderá criar a face. 

 

1.7. Visualizando o Modelo 
Antes de desenharmos em três dimensões, vamos aprender como controlar a visualização do 

modelo. 
A ferramenta mais versátil para rodar o modelo no espaço é o comando de órbita (Orbit). 

Selecione o comando Orbit , pressione e arraste o cursor na área de desenho. 

 
O comando órbita (Orbit) gira a vista do modelo em torno de um ponto central. Você pode 

usá-lo para visualizar seu modelo dinamicamente de qualquer ponto no espaço, de cima, de baixo, 
ou de qualquer lado. 

Dica: Se você tiver um terceiro botão no seu mouse, você poderá usá-lo para girar seu 
desenho com Orbit. 

Algumas vezes o comando Orbit não te mostra o que você quer ver, e você pode precisar de 

olhar mais de perto. Para isto use a ferramenta Zoom.  
Agora clique e arraste o cursor para cima e para baixo na tela. O desenho aproxima 

movendo o mouse para cima e afasta movendo para baixo. 
Dica: Se você tiver um mouse com um disco central, você pode ativar o Zoom com ele. 
Se você se perder no espaço, você pode retornar para uma orientação familiar clicando no 

botão Iso View . Você pode também ativar o Zoom Extents, que irá centralizar o modelo todo 

na tela.  

Outra ferramenta valiosa para trabalhar no seu modelo é o comando Zoom Window:  
O comando Zoom Window permite colocar um retângulo numa parte do desenho que você 

deseja ver em detalhe ampliado. Isto é usado para trabalhar no detalhe do modelo. 
Quando terminar de ver os detalhes, volte à vista anterior com o comando Zoom Previous. 
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1.8. Modelando em 3D 
 

As técnicas usadas para criação de formas em 2D podem ser aplicadas para o modelamento 

3D. Para este exercício vamos modelar uma caixa 3D, usando apenas o comando Line . 
Desenhe um retângulo como ensinado em Criando Faces. 

 

Enquanto no comando Line , clique num vértice do retângulo. Verifique a referência 
verde e a dica de “Endpoint” para confirmar que o ponto correto está sendo escolhido. 

 
Mova o cursor até a linha ficar azul indicando o alinhamento com o eixo azul. A dica “On 

Axis” deverá aparecer. 

 
Dica: Como você está desenhando em perspectiva, sua linha pode não parecer estar 

perfeitamente paralela ao eixo azul na tela. Você pode confiar que o SketchUp acha o alinhamento 
correto para você. 
 

Clique o segundo ponto para finalizar a linha vertical. Agora continue desenhando 
arrastando o mouse paralelo ao eixo verde. Verifique o alinhamento com o eixo verde. Enquanto 
aparecer a dica “On Axis”, arraste o mouse até alcançar o “endpoint” do lado de baixo do seu cursor. 
Você saberá que tem o ponto correto quando a dica “From Point” aparecer, e também uma linha 
tracejada azul com dois pontos pretos. Clique para desenhar o segundo lado da sua nova face. 
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Agora clique o vértice final (de volta ao retângulo inicial) para fechar esta face. Verifique 

que a dica “Endpoint” aparece: 

 
Duas faces contêm uma aresta comum neste caso. O SketchUp entende isto ao completar 

esta face. 

 
Vamos continuar desenhando faces ao redor do retângulo original. Como o SketchUp já 

sabe que linhas existentes podem ser arestas em novas faces, você pode desenhar a próxima face a 
partir do canto superior direito da face anterior. Observe as dicas de precisão do SketchUp. 
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Na imagem acima, você pode ver que a linha é paralela ao eixo vermelho, e que seu ponto 

final está diretamente acima do seu retângulo base. Feche a face clicando de volta no retângulo 
original. Desenhe a próxima face clicando no ponto acima e à direita: 

 
Quando a dica de precisão do SketchUp não aparecer mova o mouse um pouco sobre o 

ponto ou linha ao qual você deseja alinhar: 

 
Depois, mova o mouse acima na direção azul. Você deverá ver uma linha tracejada azul e a 

dica “From Point” quando parar o mouse. Continue movendo acima até a linha se tornar verde 
mostrando o alinhamento aos outros pontos do topo da caixa: 

 
Quando alinhado, clique. Complete a face clicando no retângulo da base. 
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O SketchUp só precisa de mais uma linha para completar a caixa. Desenhe esta linha. 

 
Desde que você tenha clicado nos pontos corretos, o SketchUp fechará o objeto 3D para 

você. Muito bem você completou o modelo 3D! 

 
 

1.9. Usando o comando Push/Pull (Empurrar/Puxar) 

Mesmo podendo desenhar quase tudo no SketchUp com a ferramenta Line , há outro 

modo mais rápido de transformar faces 2D em objetos 3D. A ferramenta Push/Pull  permite 
alterar rapidamente a massa e a proporção das formas. Vamos fazer a caixa do exercício anterior de 
forma mais simples. 

Ative a ferramenta Rectangle  para desenhar o retângulo. 
Depois, clique num ponto na janela de desenho e mova o cursor diagonalmente para criar o 

retângulo, clicando no canto oposto. Ou você pode pressionar o botão do mouse na tela e arrastar 
diagonalmente na tela, e depois soltar o botão do mouse para completar o retângulo. Para entrar 
com a mesma medida do retângulo anterior (300cm x 240cm), vamos digitar 300;240 e a tecla Enter. 
Note que estamos dando primeiro o valor do lado paralelo ao eixo X e depois o valor do lado 
paralelo ao eixo Y, separados por ponto-e-vírgula. 
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Agora, Ative a ferramenta Push/Pull:  
Clique no retângulo criado… 

 
...e mova para cima para extrudá-lo em 3D. 

 
Note que enquanto você arrasta o mouse durante a operação Push/Pull o valor é mostrado na 

VCB (Value Control Box = Caixa de Dados). Portanto você pode entrar com valores precisos, 
digitando o valor (250, por exemplo) e apertando Enter. Este valor é relativo ao ponto inicial do 
Push/Pull. Digitando distâncias sucessivas move a face naquela distância, relativa a posição inicial. 
 

1.10. Criando um Telhado Simples 
Agora vamos criar modelos com dimensões reais, usando a caixa de dados no canto inferior 

direito da tela: Value Control Box (VCB). 
Vamos começar com um retângulo de 300cm de largura (em X), 600cm de comprimento 

(em Y) e 240cm de altura (em Z). Ative a ferramenta Rectangle , e clique para indicar o 
primeiro vértice do retângulo da base. 

Enquanto você arrasta o retângulo, verifique a VCB e note como ela mostra duas dimensões 
dinamicamente, separadas por ponto-e-vírgula. Estas representam as dimensões de cada lado. 
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Clique para completar o retângulo. Logo em seguida, você pode especificar dimensões 

precisas, Digite 300;600 e pressione Enter. O retângulo será alterado para estas dimensões. 

 
Nota: O SketchUp irá interpretar qualquer dado com a unidade colocada como preferência 

do usuário (“Menu Window > Model Info > Units”) a menos que você especifique uma unidade 
após o valor. Para pés coloque uma apóstrofe depois do número (10’), a letra m para metros (3m), 
cm para centímetros (300cm), etc. 

A maioria das ferramentas do SketchUp usam a VCB da mesma forma. Para o próximo 

passo ative a ferramenta Push/Pull , clique no retângulo, e mova o mouse para cima. 
Para este modelo queremos a extrusão com exatos 240cm, portanto entre o valor de 240 e 

tecle Enter. O SketchUp irá ajustar a operação de Push/Pull para os exatos duzentos e quarenta 
centímetros. 

 
Vamos agora fazer o telhado. Trace uma linha do ponto médio da face superior do objeto. 

Use a dica de “Midpoint” para ter certeza e clique. Mova o cursor até o ponto médio da aresta 
oposta, e clique no ponto final da linha.  

 
Esta linha dividiu a face superior do objeto em duas, operação chamada de introdução de 

aresta. 

Agora, ative a ferramenta Move/Copy:  
Mova o cursor sobre a última linha desenhada. Note que como nada havia sido selecionado 

previamente, a ferramenta Move/Copy percebe as geometrias que podem ser movidas, iluminado-as 
na cor amarela. 
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Clique a linha e mova o mouse para cima. Para ter certeza que você está movendo para cima, 

procure pela linha azul de referência e pela dica de seleção “On Axis”. Isto irá formar a cumeeira do 
telhado de duas águas. 

 
 

Algumas vezes o SketchUp não consegue saber qual alinhamento você deseja. Se isto 
acontecer, arraste a linha mais para cima até você ver a linha tracejada azul de referência e depois 
volte para a posição desejada pressionando a tecla Shift para trancar a referência vertical. Enquanto 
você segura a tecla Shift, a direção do movimento permanecerá na vertical. 

 
Você pode também usar a caixa VCB para entrar com uma distância precisa da altura da 

cumeeira. Para colocar uma altura de cento e cinqüenta centímetros, digite 150 e depois Enter logo 
após mover a linha. 

 
Salve seu desenho, “Menu File > Save as...” escolha um diretório e salve o desenho com o 

nome de casa3D.skp. 
 
 

1.11. Criando uma janela água-furtada 
 

Estivemos desenhando formas básicas até agora. Este exercício irá demonstrar como 
desenhar formas tri-dimensionais em relação a um plano inclinado. Para começar, abra o modelo 
(casa3D.skp),salvo no exercício anterior. 

Usando o comando Line , desenhe um retângulo vertical na aresta do telhado. Lembre-
se de usar a referência “On Axis” para manter seu retângulo coplanar com a parede da casa. 
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Depois, crie uma linha vertical a partir do ponto médio do lado superior do retângulo. Para 
fazer isto, mova o mouse em cima do ponto médio do lado, sem clicar e mova o cursor para cima. O 
SketchUp irá mostrar o alinhamento correto com uma dica de “From Point”. 

 
 

Determine o topo da janela água-furtada com um clique, e desenhe as linhas de ambos os 
lados. Isto completa a face da janela água-furtada. 

 
 

Agora que temos a frente, vamos desenhar a linha da cumeeira da janela água-furtada. O 
SketchUp irá ajudá-lo a achar o ponto correto onde a cumeeira encontra o plano da água do telhado 
com a dica “On Face” e um ponto de referência azul. Verifique o alinhamento correto ao eixo 
apropriado também, com a linha temporária vermelha, paralela ao eixo vermelho X. 
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Em seguida, use a mesma técnica para desenhar as linhas dos planos inclinados. 

 
 

Depois, desenhe linhas conectando as interseções com o telhado. 

 
 

Você deve usar a ferramenta Orbit  para desenhar do outro lado da janela água-furtada. 

 
 

Para completar, ative a ferramenta Eraser  e apague a linha desnecessária na face 
frontal. 

 
Você completou a janela água-furtada. Salve este arquivo para usar no próximo tutorial. 

Clique no comando Save . 



CENTRO UNIVERSITÁRIO METODISTA IZABELA HENDRIX 
Curso de Arquitetura e Urbanismo - Disciplina de Informática 

Elaborado pela professora do Centro Universitário Metodista Izabela Hendrix Arq. Cecília Santos Franco 
 

 

19
1.12. Criando Aberturas em Faces 

Como você aprendeu em outros tutoriais, desenhando uma série de linhas conectadas e 
coplanares, irá criar uma face, e desenhando uma linha através de uma face irá dividi-la. Este 
tutorial descreve como criar faces dentro de faces. 

Comece abrindo o arquivo da casa salvo no tutorial anterior (ou abra o arquivo 

Tutorial0.skp). Primeiramente, ative a ferramenta Rectangle , e desenhe um retângulo na face 
frontal da janela água-furtada. Verifique se aparece a dica “On Face” enquanto você desenha. 

 
 

Agora ative o comando Select  e selecione o retângulo: 

 
  
Quando ele ficar iluminado (pontilhado em amarelo), apague-o apertando a tecla Delete. 

Você deverá ver um buraco na face frontal. Agora selecione a parte do telhado que você vê dentro 
da janela água-furtada e apague-o também. 

 
 

Isto ilustra um ponto importante: Enquanto você desenha, quaisquer linhas que definam uma 
forma fechada e plana, irá criar uma nova face também. Mesmo que originalmente esta não seja a 
intenção. 

Salve este arquivo para usar no próximo tutorial. Clique no comando Save . 
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2. Tutorial Intermediário 

2.1. Criando Linhas de Construção 
O SketchUp tem linhas de construção (Construction Lines), que são linhas tracejadas cinza 

claro que se estendem infinitamente através de todo o seu modelo. Elas são linhas auxiliares para 

facilitar a precisão de alinhamento. Estas linhas são criadas com as ferramentas Tape Measure  

e Protractor . 
Para começar este tutorial, abra seu arquivo da casa do tutorial anterior (casa 3D). Vamos 

usar linhas de construção para colocar com precisão uma janela de 120cm x 90cm na frente da casa.  

Vamos ativar a ferramenta Tape Measure : 
 
Clique o cursor na aresta inferior da frente da casa e mova o cursor na direção azul. A linha 

de construção é desenhada paralela à aresta que você escolheu. Clique o cursor na aresta frontal 
inferior da casa e mova o cursor na direção azul. 

 
 

Agora digite 210 (este valor irá aparecer na VCB Value Control Box) e pressione Enter. Sua 
linha de construção aparece exatamente a 210 acima da aresta inferior. 

Em seguida, desenhe a linha de construção para a parte de baixo da janela (peitoril). Clique 
no mesmo eixo como antes, e crie uma linha de construção 110 acima do chão. 

 
 

Estas duas linhas de construção irão nos ajudar a colocar as arestas, inferior e superior, mais 
precisamente. 

Agora vamos colocar a linha de construção vertical no centro da parede. Para isso, clique 

com a ferramenta Tape Measure  em um dos lados verticais da parede, e arraste a linha de 
construção horizontalmente até encontrar o ponto médio (midpoint) da aresta inferior da parede. 
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Ative a ferramenta Rectangle . Comece de uma intercessão das linhas de construção, e 
mova o cursor para a outra linha de construção paralela. Na VCB observe para fazer a janela com 
100cm de altura e 120cm de largura, ou digite (120;100) e pressione Enter.  

Dica: Quando uma das dimensões do retângulo já está correta, você só precisa de digitar o 
valor da outra dimensão. No exemplo acima, você poderia simplesmente digitar 120 e pressionar 
Enter. Se depois você quiser retificar o valor para uma janela de 90cm de altura, você pode digitar 
( ;90). O ponto-e-vírgula diz ao programa SketchUp para deixar o primeiro valor como está e alterar 
apenas o segundo. 

 
Complete a janela selecionando o retângulo e apertando a tecla Delete. 

 
 
 
Agora você pode apagar as linhas de 

construção usando o comando Eraser . Se 
você achar que pode precisar delas depois, você 
pode escondê-las selecionando-as e escolhendo 
Hide no “Menu Edit”. (Uma maneira mais rápida 
seria escolher “Menu Edit > Construction 
Geometry > Hide All”. Quando quiser ver as 
linhas de construção novamente, escolha “Menu 
Edit > Construction Geometry > Unhide All”. 
Para apagar definitivamente todas as linhas de 
construção do desenho, escolha “Menu Edit > 
Construction Geometry > Erase All”. 
 
 
 
 
 



CENTRO UNIVERSITÁRIO METODISTA IZABELA HENDRIX 
Curso de Arquitetura e Urbanismo - Disciplina de Informática 

Elaborado pela professora do Centro Universitário Metodista Izabela Hendrix Arq. Cecília Santos Franco 
 

 

22
2.2. Movendo e Copiando Faces 

Vamos continuar com a casa do tutorial anterior. Vamos mover a janela frontal para alinhá-
la com a janela água-furtada acima. 

Nota: Apertando outra tecla enquanto se faz uma operação é como se usássemos uma tecla 
de modificação do comando (Modifier Key). Teclas de modificação no SketchUp são Shift, Ctrl 
(Control) e Alt. 

Primeiramente, selecione a ferramenta Select , e selecione todos os quatro lados da 
janela. Uma maneira de fazer isto é selecionar uma linha, segurar a tecla Shift, e depois selecionar o 
resto. Seu cursor de seleção irá mostrar o símbolo +/- 

 

Agora, ative a ferramenta Move/Copy , e clique num dos vértices da janela. Usando uma 
referência linear, arraste a janela no alinhamento da janela água-furtada acima. Clique o botão do 
mouse novamente para completar o movimento. 

 
Em seguida vamos fazer outra janela, copiando a já existente. Com a janela ainda 

selecionada, e o comando Move/Copy  ainda ativo, aperte a tecla Ctrl e clique na janela 
novamente. (Você deverá ver o símbolo + próximo ao cursor de Move/Copy). Quando você mover o 
mouse, uma cópia da janela será feita. O comando Move/Copy + tecla Ctrl é o comando Copy. 
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Solte a tecla Ctrl, e digite 210 seguido de Enter. Note que quando você copiou as linhas da 

janela, o buraco (ou ausência de uma face) foi copiado também. 
E se nós quisermos duas janelas água-furtada? Você pode usar a mesma técnica para copiar 

a janela água-furtada existente. Ative o Select  e faça uma seleção por janela (“window”) em 
torno da janela água-furtada (retângulo da esquerda para a direita). 

 
 

Selecionando objetos por janela pode selecionar itens invisíveis na parte de trás do modelo. 
Isto ocorre porque a seleção por janela seleciona tudo que estiver dentro do retângulo de seleção, 
mesmo elementos atrás do modelo. Para checar o que foi selecionado, coloque a visualização em 
modo Wireframe (visualização de grade). 

 

 
Note que a linha da empena foi selecionada. Pra removê-la da seleção, Aperte as teclas Shift 

e Ctrl ao mesmo tempo e clique na linha. Note que um símbolo de menos (-) aparece ao lado do 

cursor do Select  para indicar que você está retirando itens do grupo de seleção. 
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Vamos retornar ao modo de visualização Shaded . Ative o Move/Copy , segure a 

tecla Ctrl e clique no canto superior direito da primeira janela. Esse será um ponto de referência 
para começar nossa cópia. Agora clique no canto superior direito da segunda janela, para completar 
a cópia. Note que o buraco no telhado abaixo da janela água-furtada foi parte da seleção, portanto 
foi copiado também. 

 

2.3. Escondendo (Hiding) e invertendo (Reversing) Faces 

2.3.1. Escondendo Faces 
Escondendo geometria, temporariamente ou permanentemente, pode promover melhor 

visualização do modelo. O SketchUp proporciona várias formas de fazer isto: 
A maneira mais fácil é pelo menu de contexto (Context Menu). Para ativá-lo, coloque o 

mouse sobre a entidade e aperte o botão direito. 
Vamos esconder algumas faces para trabalharmos dentro do modelo: 

 

Ative o Select , e clique o botão da direita do mouse na face do objeto. Selecione “Hide” 
do menu. 

 
Esta operação apenas esconde a face, sem apagá-la. 
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2.3.2. Escondendo Lados 

Agora, vamos esconder arestas. Usando a ferramenta Eraser  e segurando a tecla Shift, 
selecione as arestas. Elas serão escondidas e não apagadas. Use este método para esconder toadas as 
arestas das faces que escondemos anteriormente. Agora você pode trabalhar dentro do modelo, 
desenhando elementos dentro dele.  

 
Você pode ver o que foi escondido, selecionando “Menu View > Hidden Geometry”. Faça 

isso agora. Note que as faces que foram escondidas aparecem como grades na tela, e todas as 
arestas escondidas aparecem como linhas tracejadas. 

 
Neste modo, você pode selecionar superfícies e arestas como geometria visível. Esta é uma 

forma útil de ter acesso à geometria escondida sem ter que esconder e mostrar seguidamente. Para 
voltar e ver a geometria, selecione a face ou aresta, aperte o botão direito do mouse sobre ela e 
selecione Unhide do menu de contexto. 
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2.3.3. Invertendo Faces 

Faces no SketchUp tem dois lados. Isto significa que cada lado da face tem frente e verso. O 
SketchUp mostra isto colorindo a frente da face de marrom, e o verso de azul. 

Nota: Isto é importante se você pretende exportar seu modelo nos formatos de arquivo 
DWG, DXF, 3DS, ou VRML 3D, pois o SketchUp só preserva a cor marrom da frente das faces. 

Você pode reverter a orientação de uma face usando o menu de contexto. Selecione algumas 
faces, clique com o botão direito em qualquer parte da seleção, e selecione Reverse. As faces vistas 
de frente são desenhadas na cor marrom. 

  

Se você girar seu modelo com Orbit , você verá a diferença entre a frente e verso de 
suas faces. 

 

2.3.4. Mostrando Objetos (Unhiding) 
Você pode mostrar novamente todas as entidades escondidas selecionando “Menu Edit > 

Unhide > All”. 
Mas suponhamos que você queira mostrar algumas das entidades que foram escondidas. 

Escolha “Menu View > Hidden Geometry > marque esta opção”. Isto irá mostrar a geometria 
escondida e permitir selecioná-la. Selecione as geometrias que você deseja mostrar, e depois 
escolha “Menu Edit > Unhide > Selected”. 

Para desligar a grade desenhada para realçar a geometria escondida, escolha “Menu View > 
Hidden Geometry > desmarque esta opção”. 

 

2.4. Fazendo Medidas Precisas 

As ferramentas Tape Measure  e Protractor  podem fornecer informações precisas 
sobre o seu modelo rapidamente. Elas fornecem comprimento, distância, e medidas angulares sobre 
a geometria e linhas de construção. 
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2.4.1. Usando a ferramenta de Medida (Tape Measure) 

Vamos usar o Tape Measure para medir a distância entre dois pontos. Pra começar, abra o 
arquivo Tutorial4.skp. 

 

Em seguida, ative a ferramenta Tape Measure:  
Vamos medir a altura do prédio. Segure a tecla Ctrl e selecione um ponto na base do modelo. 

Arraste o cursor para cima até uma linha de referência vermelha apareça, com a dica “From Point”. 

 
Leia o número na VCB Value Control Box. São 609,6cm? Se for você mediu corretamente. 

A precisão do valor (número de casas decimais após a vírgula) mostrado é controlada pela opção 
Units da caixa de diálogo “Menu Windows > Model Info > Units”. 

Nota: Quando você segura a tecla Ctrl enquanto usa a ferramenta Tape Measure, nenhuma 
linha de construção é criada. 

Usando a Ferramenta Protractor    
O transferidor (Protractor) mede o ângulo entre duas linhas retas. Vamos medir a inclinação 

do telhado. 

2.4.2. Ative a ferramenta Protractor. 

 Um transferidor circular ficará ligado com seu ponto central no final do cursor do 
mouse. Coloque o ponto central no vértice superior de uma das paredes… (aguarde pela referência 
Endpoint) 
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... e clique uma vez para colocar o vértice base do ângulo que você deseja medir. Agora, 

mova o mouse para a direita. Espere a referência de eixo vermelha aparecer indicando que você está 
arrastando paralelamente ao eixo vermelho (e, portanto o plano do chão). Clique novamente para 
colocar a linha base do ângulo. 

 
 

Neste ponto aparece uma linha de construção através do centro do transferidor (Protractor). 
Use o cursor para colocar o indicador na aresta do telhado. O tamanho do ângulo é mostrado na 
caixa de dados Value Control Box. Se você encontrar o valor de 45 graus, está correto. Clique o 
mouse para fazer a linha de construção neste ângulo se quiser, se não pressione a tecla Escape para 
cancelar a operação. 

 
 

2.5. Fazendo cópias múltiplas com Arrays 

2.5.1. Arrays Lineares 
Você pode fazer vários tipos de arrays Multi-Copy (cópias múltiplas). Usando Multi-Copy, 

você pode basicamente repetir uma cópia com movimento ou cópia com rotação em qualquer 
direção.  

Para começar, abra o arquivo Tutorial8.skp. 
O primeiro passo é usar a ferramenta Move/Copy para fazer uma cópia. Como você já sabe a 

cópia é feita usando Move/Copy  com a tecla Ctrl pressionada. 
Depois de fazer a cópia inicial, você pode fazer a Multi-copy. Digite 3x e Enter para “três 

cópias”. Isto é chamado de uma array externo, porque ele se estende para além da sua distância 
inicial do copy. Você pode continuar digitando valores de array, Digite 4x e Enter para “quatro 
cópias”. O SketchUp irá atualizar o array. 
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Uma coisa interessante sobre Multi-Copy é que a distância entre cópias pode ser colocada a 
qualquer momento. Isto não irá alterar o número de cópias, simplesmente ajusta o espaçamento. 
Isso permite que você teste o array com facilidade. Digite uma distância de 3m e Enter e observe o 
resultado. 

Agora, vamos mudar para um array interno. Primeiro, digite uma distância maior de 10m e 
Enter, e depois digite 5/ e Enter para “cinco divisões”. Nós chamamos isto de um array interno 
porque ele interpola divisões iguais entre o original e a cópia. 

 
 

Você pode continuar a digitar novas distâncias e/ou valores de multiplicador/divisor quantas 
vezes quiser até que você ative outra ferramenta ou faça nova operação. Esta é uma ótima forma de 
criar colunas regulares.   
 

2.5.2. Arrays Circulares 

Para criar arrays circulares, use a ferramenta Rotate  de forma similar ao descrito acima. 

Selecione a caixa da direita com o comando Select , e ative a ferramenta Rotate . 
Coloque a base da rotação, segure a tecla Ctrl. Note que um sinal de mais (+) é adicionado 

ao cursor para indicar que você fará uma cópia. 

 
Permaneça pressionando a tecla Ctrl e clique para selecionar um segundo ponto base. 

Quando arrastar você pode colocar visualmente a cópia. Clique para finalizar. Você está pronto para 
fazer cópias circulares múltiplas. 
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Use a mesma sintaxe do array linear. Digite 7x e Enter para “sete cópias.” 

 
 

Da mesma forma de antes, você pode digitar valores de ângulos de rotação, multiplicadores 
de array externos, e divisors de arrays internos quantas vezes quiser até iniciar uma nova operação.  

Com Multi-copy em ambas as ferramentas Move/Copy e Rotate, o SketchUp permite que 
você faça estudos que mais se adequem ao seu projeto. 

 

2.6. Inserindo Componentes 
Componentes são arquivos do SketchUp que são 

colocados no modelo como objetos (são blocos de biblioteca 
de símbolos). Você pode criar seu próprio objeto dentro do 
SketchUp, ou você pode inseri-los de outro arquivo ou 
biblioteca. 

Componentes podem comportar diferentemente: 
componentes independentes como mobiliário são livres para 
movimentar para qualquer lugar, e componentes que se 
“ligam” em superfícies como portas e janelas.  

Inserindo um Componente 
Componentes podem ser colocados com o navegador 

de componentes (Component Browser). Abra o navegador 
selecionando-o no “Menu Window >componentes”. 

 
O navegador lista todos os componentes da biblioteca 

padrão. Agora navegue para o diretório “Seating”, clique no 
componente “ChairDesk01”, e mova o cursor para a janela de 
desenho. 
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O ponto no qual o componente será colocado é chamado de ponto de inserção (placement 

point). 
Quando a cadeira estiver na posição desejada, clique o mouse. Depois de inserir o 

componente, o SketchUp irá ativar automaticamente o comando Move/Copy. A caixa amarela em 
torno da cadeira é usada para indicar que o componente está selecionado. 
 

2.7. Rodando um Componente 
Esta caixa de seleção pode também ser usada para rodar componentes de uma forma 

conveniente usando o comando Move/Copy. Note os “grips” de rotação vermelhos que aparecem 
como pequenos sinais de mais (+) vermelhos. Mexendo o mouse sobre estes pontos mostra o 
transferidor de rotação. Tente mover sobre a cadeira e sobre um dos grips de rotação. 

 
 

Clique para girar a cadeira. Note o ângulo de rotação sendo mostrado na VCB. Clique 
novamente quando estiver na rotação desejada. 
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2.8. Movendo Componentes 

Vamos desenhar um retângulo à direita da cadeira. Desenhe um segundo retângulo dentro do 

primeiro e use a ferramenta Push-Pull  para criar uma plataforma elevada: 

 

Ative o Select  e clique na cadeira para pré selecioná-la. Você verá a caixa de seleção 

contornando a cadeira. Agora ative a ferramenta Move/Copy . Clique numa área em frente da 
cadeira, mas não sobre ela, no plano vermelho-verde. Note que enquanto você move o mouse para a 
direita da tela, a cadeira também se move. 

 
Note também que enquanto você move o mouse para além da plataforma elevada, a cadeira 

continua a mover através da plataforma, permanecendo nivelada com o plano do piso. Vamos tentar 
algo diferente… Aperte Esc para cancelar o Move/Copy.  

 
Desta vez, coloque o cursor do Move sobre o assento da cadeira até que apareça a dica “On 

Face in Component” e clique. Isto coloca o ponto base do movimento. 
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Agora mova a cadeira sobre a superfície do retângulo e sobre a superfície da plataforma 

elevada. Note que o ponto base que você selecionou controla onde a geometria do componente será 
posicionada em relação à outra geometria no restante do modelo... 

 
O ponto no componente debaixo do cursor quando você começa o movimento é chamado de 

“Pick Point”. Durante a operação de Move você está segurando o objeto por este ponto como o 
ponto de referência para o movimento. Se você quer mover o objeto com precisão, escolha com 
cuidado o ponto inicial do Move. 

Vamos colocar a cadeira sobre a plataforma. Mova o cursor sobre a cadeira. Use o Zoom 

 para aproximar da cadeira e colocar o cursor na base de uma dos pés até aparecer a dica 
“Endpoint in Component”. 

 
Agora simplesmente mova a cadeira para o lugar desejado no topo da plataforma! 

 
Use este método para fazer o “snap” em componentes. 
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2.9. Mudando a Escala de Geometrias e Objetos 

Qualquer desenho feito no SketchUp pode ser re-escalado dinamicamente com a ferramenta 

Scale . Como com outras ferramentas, você pode trabalhar livremente, ou com precisão. O 
comando Scale permite mudar o tamanho do objeto em qualquer direção, ou fazer operações de 
espelhamento (mirror). 

Comece abrindo o arquivo Tutorial7.skp. 

 

Selecione o que deseja alterar o tamanho com a ferramenta Select . Superfícies 
individuais podem mudar o tamanho em 2D, mas vamos selecionar um volume 3D.  

Clique no comando Scale  na barra de ferramentas Edit: 

    >    
Uma caixa de seleção irá aparecer em torno de sua seleção. Cada cubinho verde é um grip 

de mudança de tamanho. 

 
Quando você move o cursor sobre cada grip, este e sua âncora oposta ficarão vermelhos, e 

um vetor tracejado será desenhado entre eles. Este vetor indica a direção da operação de mudança 
de tamanho. Faça tentativas com vários grips. 

Para isso, clique no grip, e mova o mouse para alterar o tamanho da geometria. Clique 
novamente para finalizar. Note que mesmo grips escondidos aparecem quando o mouse está sobre 
eles. Observe também que dando duplo-clique no grip, você pode pressionar e arrastar para mudar o 
tamanho. 
 

2.10. Tipos de Grip 
Note que os grips são organizados dentro de um paralelepípedo de contorno, e cada grip faz 

um tipo de escala. Isto corresponde ao número de faces que cada grip toca. 
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Os grips posicionados no centro de cada “face” da caixa de contorno, permitem mudar o 

tamanho do objeto numa direção específica. 

 
Os grips no ponto médio de cada “aresta” da caixa de contorno toca duas arestas, e permitem 

mudar o tamanho do objeto em duas direções. 

 
Os grips nos “vértices” da caixa de contorno toca três faces, e permitem operações de escala 

em todas as três direções simultaneamente. 

 
Se você parar sobre o grip, uma dica descreve o tipo de operação que poderá ser feita. 

 
Teste cada tipo de grip. Note que enquanto a operação de escala é feita, o fator de escala 

aparece na VCB (Value Control Box), e o valor prende no tamanho de 50% e 100%. 
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2.11. Teclas de Modificação (Modifier Keys) 

2.11.1. Tecla Uniforme/Não-Uniforme 
Ambos os grips, no centro da face ou ponto médio da aresta permitem escalas uniforme e 

não uniforme. Você pode alternar este comportamento para fazer o objeto transformar o tamanho 
uniformemente segurando a tecla Shift. 

Insira um componente de biblioteca árvore (Tree). Do “Menu Window > Components”. 
Navegue para o grupo Landscape e insira uma das árvores. Use o comando Scale para mover o grip 
da superfície superior para cima e para baixo. Nós queremos que a base da árvore seja o ponto base 
do tamanho, mas isto deforma a árvore... 

 
Agora, tente segurando a tecla Shift. Isso muda a operação mudança de tamanho de 1D para 

3D. Tente isto usando outros componentes do SketchUp. 
Diferentemente dos outros grips, os grips de vértice fazem o tamanho em todas as direções. 

Apertando o shift, você libera o tamanho em todas as direções de forma não-uniforme. 

2.11.2. Mudando escala a partir do centro 
Você pode forçar a operação de escala a partir do centro de massa da caixa de contorno 

como ponto base. Para fazer isso, segure o grip de vértice e comece o tamanho. Enquanto você faz a 
operação, segure a tecla Ctrl. Quando você libera a tecla no meio da operação, o tamanho reverte 
para usar o ponto oposto. 

 
As teclas Ctrl e Shift podem ser usadas em conjunto, para permitir escala Uniforme/Não-

Uniforme a partir do centróide da geometria selecionada. Estas combinações permitem ao usuário 
uma gama de formas de mudar o tamanho de forma eficiente e rápida. 

 

2.12. Trabalhando com Precisão usando a VCB 
A qualquer momento ou imediatamente após a operação de escala, você pode digitar um 

fator de escala preciso na Value Control Box (VCB). 
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2.12.1. Fator de Escala (Scale Factor) 

Segure e mova um grip de vértice. Agora digite 2 e pressione a tecla Enter. Note que o 
objeto fica com 2 vezes o seu tamanho original (200% maior). Agora digite 1,5 e a tecla Enter. Note 
que o objeto fica uma vez e meia maior (150% maior). 

Nota: Como todas as ferramentas do SketchUp, você pode continuar a entrar novos valores 
da VCB até que você mude de comando. 

 

2.12.2. Distância (Distance) 
Além do fator de escala, você pode digitar uma distância. Pegue um grip na face superior e 

mova-o na tela. Desta vez, em vez de um valor numérico, digite uma distância de 150cm (é 
necessário escrever a unidade cm) e aperte Enter. Note que o tamanho do objeto ao longo da 
direção tracejada se torna o exato valor da distância. 

É importante lembrar que para distâncias, você precisa especificar a unidade como parte do 
valor digitado. Por exemplo, 5’ para cinco pés, 3m para três metros, 300cm para trezentos 
centímetros, ou 5’6” para cinco pés e seis polegadas. Se você digitar somente um valor numérico, o 
SketchUp irá interpretá-lo como um fator de escala. 

 

2.12.3. Direções Múltiplas 
A VCB usa valores numéricos separados por ponto-e-vírgula quando valores múltiplos estão 

presentes. Você pode especificar valores exatos de escala incluindo vírgulas na entrada de dados. 
Para ver como isso funciona, tente mover um grip de ponto médio de aresta. Você verá duas 

direções mostradas com valores mudando dinamicamente. 

 
 

Agora digite 1,5;3. O objeto se torna uma vez e meia maior em uma direção e três vezes 
maior na outra direção. Desde que você não mova outro grip, ou mude de comando, você pode 
continuar a digitar outros valores para experimentar diferentes proporções de seu modelo. Se você 
quiser especificar o segundo valor deixando o primeiro como está, você pode digitar um ponto-e-
vírgula seguido pelo novo segundo valor: ;4 

Antes de prosseguir, tente digitar -1;1. Isto fará o objeto espelhar, produzindo uma imagem 
espelhada. 

Dica: Digitando um valor negativo faz a ferramenta Scale  espelhar a geometria naquela 
direção. É a maneira de acionar o comando Mirror (espelho). Outra maneira de espelhar os objetos 
é selecioná-los, clicar sobre a seleção com o botão da direita e no menu de contexto escolher a 
opção “Flip Along > Red Direction (ou Green Direction ou Blue Direction)”, conforme a direção 
do espelhamento desejada. 
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Os três valores disponíveis enquanto mudando o tamanho usando o grip de vértice 

trabalham da mesma maneira: 

 

2.12.4. Mudando a Escala de Elementos 
Até agora, trabalhamos com escala de grupos e componentes, mas você pode usar a 

ferramenta Scale  em elementos isolados também. Para testar, desenhe um círculo (Circle ) 

e use Push/Pull  para extrudá-lo num cilindro. 

Em seguida, selecione a superfície superior do cilindro com a ferramenta Select  e ative 

o comando Scale . Porque você está mudando o tamanho de uma face 2D, os grips de escala 
estarão dentro de um retângulo em vez de uma caixa de contorno. Brinque com os grips de escala e 
teclas de modificação para ver como isso afeta a geometria. 
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2.13. Mais Dicas da Ferramenta Scale 

2.13.1. Salve valores da VCB 
É usualmente melhor entrar valores específicos DEPOIS que você completou a operação de 

escala com o mouse. Como há muitas maneiras de trabalhar com o tamanho, teclas de modificação 
podem interferir quando você quer entrar com valores específicos durante a operação de escala. Por 
exemplo, tentando digitar valores enquanto segura a tecla Ctrl pode ativar outras ferramentas, ou 
pressionando Shift para indicar polegadas usando o símbolo " (aspas duplas) pode mudar para o 
tamanho uniforme. 

 

2.13.2. Componentes e Eixos 
Um componente único ou grupo muda o tamanho preferencialmente na direção de seus 

eixos. Isto facilita a mudança de escala baseada na orientação original em que foram criados. Se 
você quiser mudar o tamanho em relação à posição corrente dos eixos, inclua o seu componente 
como parte de um grupo de seleção maior. Isso pode ser feito desenhando uma linha e incluindo-a 
no grupo de seleção. 

Experimente com o comando Scale . 
 

2.14. Introdução a Camadas (Layers) 
Existem vantagens em organizar a entidades do SketchUp desenhando em camadas (layers). 

Isso permite que você controle a cor e/ou a visibilidade de muitas entidades de uma só vez. 
Para começar, abra o arquivo Tutorial9.skp. 
Layers são criadas usando o gerenciador de camadas (caixa de diálogo: Layers). Selecione-a 

no “Menu Window > Layers”. 

 
 

2.14.1. Criando uma Nova Layer 
Para criar uma nova camada, clique o botão Add no canto superior esquerdo da caixa de 

diálogo de Layers. Uma nova Layer aparece na lista com o nome de Layer1. Vamos trocar seu 
nome para "Parede". 
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Na coluna Visible, desmarque a caixa de seleção. Isto irá tornar a camada invisível. Todos os 

objetos desenhados na camada Parede não ficarão visíveis na tela enquanto a opção “visible” estiver 
desmarcada. Os objetos não foram apagados, apenas sua visibilidade temporariamente desligada. 

 

A seguir, na janela de desenho, ative a ferramenta Select  e clique o botão da direita na 
face esquerda do modelo. Selecione “Entity Info” do menu de contexto. A caixa de diálogo Entity 
Info aparece. Selecione a layer Parede. Isso move a face para a camada, que está na condição de 
invisível. Ao fazer isso você verá a face desaparecer. 

 

 
Você pode trocar a visibilidade da camada Parede no gerenciador de camadas (caixa de 

diálogo: Layers), o que fará reaparecer aos objetos colocados nesta camada. 
Você já deve estar habituado a trabalhar com camadas (layers) em outros programas de 

CAD. No SketchUp layers são únicas pois elas não separam objetos dentro delas. As layers do 
SketchUp são melhor descritas como um atributo da geometria, pois elementos e objetos em layers 
diferentes permanecem interconectados. Isso torna as layers do SketchUp úteis primeiramente por 
razões de visibilidade. Se você precisar agrupar a geometria, você pode usar grupos e componentes 
(Groups e Components). 
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2.15. Criando seus Próprios Componentes (Components) 

Vamos aprender a fazer um Componente.  
Inicie um novo desenho. Use (Menu File > New). Desenhe um retângulo no plano 

vermelho/verde com 75 centímetros de largura por 150cm de comprimento. Use Push/Pull  
para colocar uma altura de 60cm, tornando o objeto num volume 3D. 

 
 

Nota: Lembre que você não deve clicar na Value Control Box (VCB) antes de digitar um 
valor específico para operações, entre com os dados diretamante no teclado, que eles irão para VCB. 

Agora, vamos criar arestas paralelas (comando Offset ) para as arestas laterais e de 

fundo. Para isso, selecione as arestas com Select . Ative o comando Offset . 
Clique o cursor de Offset em qualquer das arestas iluminadas, e mova o cursor além dessa 

aresta, mas na direção interna da face superior. 

 
Entre 15 (15 centímetros) na Value Control Box, e pressione Enter.  

 

Agora Push/Pull  a nova face de topo, e especifique a distância de 30cm. Você modelou 
um sofá simples. 
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Se você transformar este sofá em um componente de biblioteca, você poderá utilizá-lo neste 

desenho, e em qualquer outro projeto no SketchUp. 
Selecione a geometria usando uma janela de seleção. Toda a geometria fica iluminada: 

 
Selecione o “Menu Edit > Make Component”. Isso abre a caixa de diálogo Create 

Component: 
Digite o nome “Sofá 2” para o novo componente, e deixe as outras opções como estão. 

 
 
 

2.16. Inserindo o componente 
Ative o navegador de componentes no “Menu Window  > Components”. Selecione a 

biblioteca “In Model”. 
Note que a caixa de diálogo mostra somente os componentes carregados no modelo, 

incluindo o Sofá 2. 
 
 



CENTRO UNIVERSITÁRIO METODISTA IZABELA HENDRIX 
Curso de Arquitetura e Urbanismo - Disciplina de Informática 

Elaborado pela professora do Centro Universitário Metodista Izabela Hendrix Arq. Cecília Santos Franco 
 

 

43
 

 
Clique no Sofá 2 e arraste-o para a janela de desenho: 

 
 

2.17. Criando Componentes Conectados (Attached Components) 
No tutorial “Criando Aberturas em Faces), nós criamos um telhado simples com uma janela 

água-furtada conectado a ele. Vamos converter a janela água-furtada num Componente. 

Abra o arquivo Tutorial0.skp. Ative o modo de sombreamento Shaded . 

Agora, ative o Select , e selecione a janela água-furtada. Pode ser necessário voltar ao 

modo de Wireframe  para ter certeza de selecionar toda a geometria necessária. 
 

 
 

Note que o plano do telhado foi furado para criar o buraco do encaixe da janela água-furtada 
no telhado. As arestas que tocam o plano do telhado formam a borda deste buraco. Este 
comportamento se tornará parte da definição do componente. 

Uma vez tudo selecionado, crie o componente com “Menu Edit > Make Component”. 
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Chame o componente de "Janela Água-Furtada".  
Selecione também “Sloped” da lista “Set gluing plane”. Isso significa que a face 

vermelha/verde do novo componente irá alinhar para qualquer face inclinada (Sloped, uma face que 
não está alinhada com nenhum dos eixos correntes). Agora marque “Cut opening”. Isso significa 
que o componente irá cortar um buraco no telhado em volta do seu perímetro. 

Clique “Create”. O Componente aparece na lista de “In Model”. Note que desde que a opção 
“Replace selected” esteja marcada, os elementos individuais que você selecionou ficam substituídos 
pelo componente Janela Água-Furtada, mostrado pela caixa de seleção. Isso é um Componente 
conectado. 

 
No SketchUp, um componente é uma coleção de geometrias que podem ser reutilizadas. 

Todas as ocorrências (instances) de um componente são idênticas. Se você modificar o componente, 
todos os componentes inseridos modificam também. 

Agora vamos colocar uma nova Janela Água-Furtada no modelo. Selecione a janela água-
furtada no navegador, e arraste-o para o telhado do modelo. Clique o ponto de inserção para o plano 
do telhado onde deseja colocá-lo. 
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Note que o telhado foi furado da mesma forma que na janela água-furtada original. 
Vamos fazer uma janela na parede. Desenhe um retângulo de 60cm x 120cm na parede. Use 

Push/Pull para furar a abertura da janela 15cm para dentro da parede: 

 
Agora apague a superfície da janela e selecione todas as arestas em torno da abertura para 

criar o componente Janela. 

 
Novamente, depois de tudo selecionado, crie o componente Janela com “Menu Edit > Make 

Component”. 

 
 
Chame de “Janela 01”, marque também “Cut Opening” e vertical. Isso fará a janela alinhar-

se com qualquer face nos planos verticais (vermelho/azul e verde/azul). 
Clique “Create” para criar o componente. Você verá “Janela 01” aparecer na lista “In 

Model”. 
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Vamos colocar a janela no modelo. Selecione “Janela 01” no navegador componentes, e 

arraste-a para a parede desejada. 

 
Note que ela corta um buraco na parede. 

 
Salve esse desenho para usar em outros tutoriais, com o nome de tutorial_casa3D.skp. 

 
 

2.18. Pintando Componentes 

Para começar ative a ferramenta Paint Bucket . 
Isso abre a caixa de diálogo “Materials”. Para este tutorial, 
selecione a biblioteca (aba Library) de materiais “Markers”. 
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2.19. Sobrepondo o Material Padrão (Default) 
 

No SketchUp, o material padrão é o material de trabalho colocado em todas as superficies e 
entidades. Você pode considerá-lo como um material não-específico. 

Grupos e Componentes podem ter materias aplicados independentemente da geometria 
dentro deles. Isso significa que quando um material é aplicado a um Grupo ou Componente, esse 
material é aplicado somente nessa entidade e não na geometria contida dentro dela. 

Isso resulta num comportamento especial no SketchUp chamado de sobreposição do 
material padrão (“Default Material Override”), onde qualquer superfície que tenha um material 
padrão (default) aplicado irá herdar o material do Grupo ou Componente no qual está inserido. 

Vamos ver um exemplo: 

Primeiramente, crie uma caixa, e use a ferramenta Paint Bucket  para colocar o material 
vermelho na superfície de topo. Deixe o material default nas outras faces. Selecione a caixa toda e 
tranforme-a num Componente. 

 

Agora, faça quatro cópias da caixa usando o comando Move/Copy  (segurando a tecla 
Ctrl), ou inserindo-as com “Menu Windows > Components”. 

 
 

Agora, pinte cada ocorrência do componente com uma cor diferente ou textura. Note que a 
face superior permanece vermelha. Você está colocando material no componente e não nas faces 
individualmente, porém as faces com o material “default”, herdam o material aplicado no 
componente. As faces com material explicitamente especificado permanecem com ele. . 
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Agora, vamos editar a definição do componente para alterá-lo. Ative Select  e dê duplo - 

clique em uma caixa para editá-la. Clique na ferramenta Paint Bucket  , segure a tecla Alt e 
clique na superfície de topo vermelha para transformá-lo no material corrente (ou use o conta-gotas). 

 
 

Pinte a face frontal de vermelho. Note que todas as faces frontais das outras ocorrências do 
componente ficam vermelhas também. Veja também, que todas as faces default mantém o material 
designado para o componente. 

 

Ative a ferramenta Select  e clique fora da caixa tracejada de edição para finalizar a 
seção de edição. 

 

2.20. Pintando o Modelo 

Abra o arquivo Tutorial10.skp. Selecione o modo de visualização Shaded . 
Vamos selecionar a palheta “Roofing” e escolher o material “StandingSeam Metal Roof” da 

lista de materiais. 
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Use o Paint Bucket  para aplicá-lo nas faces do telhado e nas janelas água-furtada. 

 
Não está como você gostaria, não é? As faces do telhado parecem corretas, mas a janela 

água-furtada fica com o material em todas as superfícies... 
Selecione o material default da casa com o conta-gotas, e pinte a janela água-furtada com ele. 

 
Agora clique com o botão da direita numa janela água-furtada e selecione “Edit Component” 

(ou dê duplo-clique na janela água-furtada). Uma vez dentro do conteúdo do componente, selecione 
o material “StandingSeam” e pinte as superfícies do telhado da janela água-furtada. Use o Orbit 

  para pintar todos os lados. 

 
Clique numa área branca da tela fora da caixa de edição para fechá-la. O modelo aparece 

pintado. 
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Este comportamento é util para aplicar materiais a partes específicas. Num carro, por 

exemplo, você coloca materiais especificos para pneus, janelas e pára-choques, mas deixa a pintura 
da lataria como default. 

 
Agora quando você faz cópias do componente do caro, você pode colocar cores diferentes 

para cada inserção, e somente a lataria muda de cor. Além disso, seu arquivo fica reduzido, pois 
você só tem uma definição do componente carro salva. 

Dica: Explodindo um Grupo ou Componente torna o comportamento da cor permanente. 
 

2.21. Fazendo um Corte 
 

Planos de Corte permitem ver o modelo cortado. Planos de Corte (Section Planes) se 
comportam como qualquer outra entidade do SketchUp, e podem ser movidos, copiados, repetidos, 
rodados, escondidos, colocados em layers, e assim por diante. Eles, entretanto, não afetam outras 
entidades, pois o efeito do corte é apenas visual. 

Para começar, abra o arquivo Tutorial11.skp. Selecione o modo de visualização Shaded . 
Para fazer um Corte, adicione um plano de corte, usando o “Menu Tools > Section Plane” 

ou clique no botão “Section Plane ” da barra de ferramentas Construction: 
Enquanto você move o mouse na janela de desenho, você deverá ver um Plano de Corte 

verde retangular ligado ao mouse. Note que o Plano de Corte irá alinhar-se com superfícies debaixo 
dele ao mover o mouse. 

 
A qualquer momento, você pode segurar a tecla Shift para trancar a orientação do Plano de 

Corte: 
Segure o cursor sobre a parede extrema da casa e então “tranque” a direção segurando a 

tecla Shift. Continue segurando o Shift e mova o Plano de Corte para onde você quer cortar o 
modelo. Vamos tentar o ponto médio da parede e o SketchUp corta uma seção através do modelo 
neste ponto. 
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Você pode reposicionar o Plano de Corte usando o Move/Copy  num canto do Plano de 
Corte (mova pelas setas do plano). Note que os Planos de Corte só moverão na direção 
perpendicular à sua face. 

 
 

2.21.1. Colocando Planos de Corte Múltiplos 
 

Você pode colocar mais de um plano de corte. Note que quando você coloca um plano ele se 
torna o corte ativo e todos os planos colocados anteriormente se tornam inativos com uma cor 
acinzentada. 

 
O lugar que o Plano intercepta o modelo é chamado de seção (Section – mostrada em 

vermelho). 
 
 



CENTRO UNIVERSITÁRIO METODISTA IZABELA HENDRIX 
Curso de Arquitetura e Urbanismo - Disciplina de Informática 

Elaborado pela professora do Centro Universitário Metodista Izabela Hendrix Arq. Cecília Santos Franco 
 

 

52
2.21.2. Mudando os Planos 

Para colocar um Plano ativo dê duplo clique nele com Select . Você pode também clicar 
com o botão da direita no plano e escolher “Active Cut” do menu de contexto. 

 
Você pode reverter a direção do corte clicando o botão da direita no plano e selecionando 

“Reverse” do menu de contexto. 

Você pode mudar a orientação mais dinamicamente com a ferramenta Rotate . 
Selecione o plano de corte. Ative Rotate e rode-o em torno de um ponto ao longo do lado da casa. 
Note que o corte é atualizado de forma dinâmica. Pressione Esc para cancelar a operação de rotação. 

 
 

Para um corte tradicional, clique com o botão direito no Plano e selecione “Align View” do 
menu de contexto. Com o ponto de vista da câmera, Você pode obter uma perspectiva de um ponto 
de vista ou uma seção ortogonal desligando perspectiva (para desligar a perspectiva, desmarque 
Perspective no “Menu Câmera”). 

 

Você pode ligar e desligar os planos de corte usando o botão “Display Section Planes”  
da barra Sections: 

 
Você pode também trabalhar na vista cortada ou no modelo completo usando o botão 

“Display  Section Cuts”  da barra Sections. 
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2.21.3. Escondendo Planos de Corte 
 

Colocando muitos planos de corte pode tornar seu modelo confuso. Você pode esconder um 
plano ativando o menu de contexto dele e escolhendo “Hide”. Usando “Menu View > Hidden 
Geometry > marque esta opção” permitirá mostrá-los novamente. Você pode também usar Layers 
ou Pages para controlar a visibilidade de grupos de Planos de Corte de uma só vez. 

 
Vamos usar seções para trabalhar dentro do modelo. Gire o modelo com Orbit até ver um 

corte no final da parte em ângulo da casa. Agora coloque o Plano de Corte na face da casa. 

 
 

Aproxime da casa com Zoom  e clique na parede dentro da casa e apague-a. 

 
 

Agora você pode ver todo o interior da casa. Tente colocar um móvel dentro da sala usando 
o “Menu File > Insert > Component...” 
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2.22. Importando um Desenho CAD 
 

Enquanto trabalhando com o SketchUp, você pode achar necessário usar um desenho CAD 
como referência. O SketchUp pode importar e exportar geometria nos formatos DWG do AutoCAD 
e DXF. 

Para importar um arquivo DWG, use o “Menu File > Import > 3D Graphic...”. Selecione o 
arquivo do tipo ACAD DWG Files (*.dwg, *.dxf). Selecione o arquivo “Floor Plan.dwg”, e clique 
no botão “Options”. 

 
 

Na caixa “Import AutoCAD DWG/DXF Options”, escolha os valores abaixo: 

 
 

Dê Ok nesta caixa e selecione o botão “Abrir” na caixa de diálogo anterior “Abrir“. 
O SketchUp irá importar o arquivo. No final, o SketchUp irá mostrar um resumo da 

importação, mostrando quantas entidades de qual tipo foram importadas com sucesso. Clique 
“Close” para concluir. 
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Nota: Durante a importação, os Blocos e Layers do CAD são traduzidos em Componentes e 

Layers do SketchUp. 
Em alguns casos, você poderá estar com um Zoom muito próximo. Quando isso ocorrer, 

clique no botão de Zoom Extents  para ver o desenho todo. Use o Orbit  para mudar para 
um ângulo de visão 3D. 

 

Vamos usar o Zoom Window  para ver mais de perto. Aproxime das portas a 45 graus no 

canto inferior esquerdo da planta. Agora, ative a ferramenta Line  e trace do interseção da 
parede externa com a porta até o canto da parede. 
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Note que a parede preenche com uma superfície. Isso é porque o algoritmo de busca de face 

do SketchUp analisa a linha no modelo e tenta criar superfícies nos lugares em que encontra linhas 
coplanares conectadas a partir da aresta traçada. 

 
Agora tente fazer isto com a parede à esquerda desta área. Note que agora você pode usar 

Push/Pull  para dar uma altura às novas faces criadas. 

 
Antes de continuarmos, considere que esse processo pode ser muito cansativo, 

especialmente num modelo grande. O SketchUp não é muito apropriado para certos tipos de 
modelos, portanto analise se o método é eficiente para atingir seu objetivo. 

Vamos verificar outros problemas em usar arquivos CAD como fonte para o localizador de 
faces do SketchUp. Dê um Zoom Window na janela à direita das portas: 

 
Note que há vários pequenos segmentos para a janela. (cada ponto final foi iluminado para 

esclarecer). Neste caso, traçar sobre cada segmento seria proibitivo.  

 



CENTRO UNIVERSITÁRIO METODISTA IZABELA HENDRIX 
Curso de Arquitetura e Urbanismo - Disciplina de Informática 

Elaborado pela professora do Centro Universitário Metodista Izabela Hendrix Arq. Cecília Santos Franco 
 

 

57
Veja que alguns segmentos não conectam nos pontos finais, então o localizador de faces não 

poderia traçar uma superfície ali. Esta condição pode aparecer em arquivos CAD. 
Por essas razões vamos tentar outra técnica: 
Crie um novo arquivo do Menu File, desenhe uma única linha, e importe o arquivo DWG 

novamente. Como o documento do SketchUp não está vazio, o arquivo CAD importado será um 
Grupo (Group). 

Dica: Se você tiver qualquer geometria no seu arquivo SketchUp antes de importar o 
arquivo CAD, o arquivo CAD será um Componente no modelo, em vez de linhas individuais. 

Agora, em vez de usá-lo diretamente, vamos usar a geometria CAD como referência para 
traçar por cima. Isso torna as faces do SketchUp separadas do desenho CAD. 

 

2.23. Importando Arquivos CAD em 3D 
Entidades 3D do CAD como faces, entidades com espessura (thickness), e malhas 3D são 

traduzidas como faces no SketchUp. Sólidos do AutoCAD NÃO são traduzidos. 
Dica: Para trazer sólidos do AutoCAD para o SketchUp, use o comando “3DSout” do 

AutoCAD para exportar um arquivo temporário. Imediatamente depois use o comando “3DSin” 
para importar o arquivo temporário de volta para o AutoCAD. Isso converte os sólidos em faces que 
podem ser importadas pelo SketchUp. 

Vamos analisar um arquivo 3D importado do CAD. Inicie um novo arquivo do SketchUp, e 
importe o arquivo  “Floor Plan3D.dwg”. Note que a lista de entidades traduzidas é mais extensa que 
a anterior. 
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2.24. Estratégias: Tamanho do Arquivo 
Importar arquivos grandes do CAD pode ser demorado. Um arquivo complexo do CAD 

pode se tornar lento no SketchUp por causa dos recursos existentes nas faces do SketchUp. 
Por essas razões, é recomendável limpar os desenhos CAD e importar apenas o 

absolutamente necessário. Pode ser interessante separar em arquivos isolados, um contendo a 
locação, outro a planta baixa outro contendo detalhes. Assim quando importados no SketchUp serão 
grupos diferentes, que você pode esconder para trabalhar com cada um individualmente. 

2.25. Importando Imagens Escaneadas (Imagens Raster) 
A importação de imagens permite que você incorpore imagens escaneadas, fax, ou 

fotografias no seu projeto. (note que arquivos dos tipos PNG e JPG são mais indicados em certas 
situações). 

2.25.1. Inserindo uma Imagem 
Hà duas formas de trazer uma imagem escaneada para o SketchUp. Você pode importá-la 

com “Menu File > Import > 2D Graphic”, ou você pode arrastar e colar a imagem do Windows 
Explorer. 

 
Quando você insere uma imagem, ela ficará ligada ao cursor. Clique para colocar o primeiro 

canto, e arraste o mouse para determinar o tamanho na tela. E clique a segunda vez para finalizar. 
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Para alterar o tamanho de uma imagem já inserida use Scale , ou clique nela com o 

botão da direita e selecione “Entity Info”. 

 

Você pode também usar o comando Tape Measure  para alterar o tamanho de objetos, 
mas isso irá alterar todos os objetos do modelo ao mesmo tempo. 

2.25.2. Movendo uma Imagem 
Você pode usar as ferramentas de edição para modificar uma imagem como qualquer 

geometria: mover, rotacionar, mudar escala. Você pode desenhar sobre uma imagem, criando um 
contexto para seu terreno. 

 
Esta é uma forma rápida de fazer estudos de urbanismo, fazendo estudo de contexto bem 

como de sombra entre edifícios. 
Dica: Se você souber exatamente o dia e a hora que a foto foi tirada, você pode estimar as 

alturas dos edifícios, comparando as sombras projetadas de geometria usando o comando Push-Pull 

. 
Você pode usar imagens para criar placas e sinalização. 
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2.25.3. Imagens como Fundo (Background) 

Imagens raster podem servir de fundo, para tal use o comando Move/Copy  num lado e 
rode o ponto para inclinar a imagem verticalmente. 

 
 

2.25.4. Sombras (Shadows) 
Note que a placa no poste projeta sombra no chão e na imagem atrás dela. 

 
 

A imagem da montanha pode ser modificada para não receber sombra clicando o botão 
direito e desabilitando “Shadows > Receive”. Isso torna o fundo mais real. 
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3. Tutorial Avançado 

3.1. Usando Trava da Referência (Inference Locking) 
Algumas vezes, o sistema de referência do SketchUp pode não alinhar como desejado. Isso é 

verdadeiro para modelos complicados ou em situações onde existem vários alinhamentos possíveis 
para o SketchUp escolher. Por exemplo, quando você está desenhando paralela a uma linha não-
ortográfica, e toca outro lado, a referência de paralela original pode se perder devido à interferência 
do lado. A solução é usar uma trava de referência (Inference Locking), que mantém a referência 
focada em determinado alinhamento. 

Para usar a trava de referência, segura a tecla Shift quando tiver a referência desejada. Essa 
referência ficara travada enquanto você move o mouse e/ou pega um ponto de referência secundário. 

 
Por exemplo, a primeira imagem acima demonstra uma linha sendo desenhada na direção 

vertical com uma linha de referência azul “On Axis”. Segurando a tecla Shift, você pode travar a 
direção de referência azul, e depois mover o mouse para obter uma Segunda referência secundária. 
A Segunda imagem demonstra o ponto de alinhamento na interseção da linha vertical azul, e o 
plano da face inclinada. 

 

3.2. Usando Dobras Automáticas (Auto-Fold) 
“Auto-Fold” automaticamente adiciona dobras em faces enquanto você trabalha. Isso é 

necessário quando uma operação faz uma face se tornar não-planar. 
Vamos criar uma caixa simples. 

Agora, Ative o Move/Copy , e comece a mover uma das arestas verticais. 

 
Note que esta operação de Move está contida no plano vermelho/verde, e que você não pode 

mover a aresta para cima na direção azul (Z). O SketchUp está tentando preservar a integridade das 
faces superior e inferior da caixa, que ficariam não-planares se você pudesse mover para cima. 

Você pode dizer ao SketchUp para ignorar esse comportamento segurando a tecla ALT antes 
de mover. Isso instrue o SketchUp a habilitar a dobra automática (Auto-Fold), e mover a aresta para 
qualquer direção sem restrição. O SketchUp faz uma dobra na face superior da caixa quando você 
move a aresta para baixo na direção azul. 
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Há movimentos que não são possíveis sem criar faces não-planares. Quando o SketchUp 

detecta essa condição, Auto-Fold inicia automaticamente. Um exemplo disso é mover um vértice na 
direção azul. 

 

Os comandos Rotate  e Scale  também podem acionar o Auto-Fold.  

No exemplo abaixo, desenhamos um hexágono, usamos Push/Pull  para extrudá-lo e 
selecionamos e giramos a face de topo. 

 

3.3. Imprimindo em Escala 
A impressão no SketchUp é feita a partir do comando Print no Menu File. Você pode ver 

uma prévia da impressão (Print Preview), ou imprimir diretamente com a opção Print. Para este 
tutorial, vamos explorar a caixa de diálogo “Print Preview” para mostrar como os diversos 
parâmetros afetam o resultado da impressão, sem desperdiçar papel. 

3.3.1. Desenhos com medidas 
Antes de começar, note que perspectivas não podem ser medidas, então a impressão em 

escala (Print To Scale) só funciona propriamente com vistas ortogonais e isométricas. Só com a 
Perspectiva desligada você terá elevações, plantas e vistas isométricas corretas. Para desligar o 
modo de perspectiva com ponto de fuga, no “Menu Camera”, desmarque a opção “Perspective”. 
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3.3.2. Imprimindo em Escala 

Selecione a vista e sombreamento desejados e desligue o modo Perspective: (Menu Camera 
> Perspective). Ative o comando “Print Preview”: (Menu File > Print Preview...). Isso abre a caixa 
de diálogo de visualização da impressão: 

 
O controle “Tabbed Page Print Range” permite imprimir tudo da tela, ou todas as páginas 

salvas no seu modelo.  
 

3.3.3. Ajustando à Página (Fit to Page) 
Na seção “Print Size”, se “Fit to Page” está habilitado, o SketchUp irá ajustar o desenho 

para caber no papel de impressão, e não irá imprimir com uma escala definida. Desabilite “Fit to 
Page”, para poder especificar a escala de impressão. 

3.3.4. Use ‘Model Extents’ 
Note o botão “Use Model Extents”.  Quando essa opção está desligada, a área a ser impressa 

é calculada da tela corrente. Isso fará que áreas brancas da tela sejam impressas. Com “Use Model 
Extents” ligado, você imprime somente a área do desenho (como com o Zoom Extents). 

Se o campo estiver desabilitado é porque você está em modo de perspectiva (Menu Camera 
> Perspective > opção está selecionada). 

3.3.5. Escala (Scale) 
A primeira medida “In the printout” é a medida no papel. A Segunda medida “In SketchUp” 

é o tamanho do objeto em escala real.. 
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Por exemplo, a escala de 1/100 será entrada como 1 = 100, isto é, 1 cm no papel (in the 

printout) é igual a 100 cm no SketchUp  (In SketchUp). 
O tamanho do formato de papel é mostrado nos itens “width” e “height”. 
Quando finalizar clique OK e uma prévia da impressão será mostrada. Esta é uma forma de 

ver o resultado antes de enviar para a impressora. Agora imprima se tudo estiver correto. 

3.4. Exportando desenhos Vetoriais em 2D 
O SketchUp permite que você exporte para um arquivo vetorial  2D, as vistas em 

perspectiva. 
Arquivos vetoriais 2D podem ser exportados em tamanho específico. Você pode incluir 

linhas de perfil (profile lines) e lados extendidos (extended edges). Texturas, sombras e 
transparências são exportados pelo SketchUp como vetores. (Estes efeitos podem ser salvos em 
imagens raster). 

Vamos Começar 
Escolha a vista desejada e o modo de sombreamento Hidden Line ou Shaded. As imagens 

abaixo são exemplos de saída: 

 
Use Menu File > Export > 2D Graphic... 
Escolha onde salvar seu arquivo. Dê um nome, e escolha o tipo de arquivo: DWG, DXF, 

PDF, EPS, etc. 
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Agora clique no botão “Options”. A caixa de diálogo permite ajustes de tamanho, escala e 

aparência do desenho 2D. Dependendo do tipo de arquivo de saída escolhido, as opções variam. 
Para imagem JPG, as opções de exportação são como na figura abaixo: 

 
Nota: O padrão é uma saída o mais próxima possível do que é visto na tela do SketchUp. 
Clique no botão Ok para as opções e em  “Export” para completar a exportação.  
Quando exportamos um arquivo para o AutoCAD, podemos definir as opções de exportação 

na caixa de diálogo “DWG/DXF Hidden Line Options”. Se a vista é mensurável, isto é, a 
perspectiva está desligada, (Menu Camera > Perspective > opção não selecionada), e você marcou 
a opção “Full Scale” (1:1)”, será salvo um arquivo de desenho vetorial de saída com dimensões 
precisas. 
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